
About VrmlPad
VrmlPad is a powerful and flexible authoring tool from ParallelGraphics that allows you to design and 
develop professional VRML content.

Use VrmlPad to create VRML worlds for publishing on the World Wide Web. VrmlPad fully supports the 
VRML 97 specification.
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Product Features

 Editing – Access to local and remote files, set bookmarks, advanced find and replace, syntax tips, 
smart AutoComplete, autoindent.

 Enhanced color-coding – Customizable by VRML keywords, field and node categories.
 Dynamic errors detecting – View and enumerate syntax and wide range of semantic errors and 

warnings – undefined identifiers, nonmatched fields, duplicated node definitions and more.
 Scene Tree – View, edit and navigate hierarchical scene structure. Synchronize selection in both 

directions. Delete, comment and rename nodes, PROTOs and field declarations.
 Resource View – View, edit and navigate document dependencies. Rename and browse all 

references to a resource. Convert, when possible, absolute references to relative and vice versa.
 Preview – Preview scenes in installed browsers and VRML viewers.
 Publishing Wizard – Organize and optimize your scene with dependencies for publishing on the Net 

and put the files on your Web server or send it by e-mail.



About VRML
The Virtual Reality Modeling Language (VRML) is a file format for describing interactive 3D objects and 
worlds. VRML is designed to be used on the Internet, intranets, and local client systems. VRML is also 
intended to be a universal interchange format for integrated 3D graphics and multimedia. VRML may be 
used in a variety of application areas such as engineering and scientific visualization, multimedia 
presentations, entertainment and educational titles, web pages, and shared virtual worlds.

Design Criteria

VRML has been designed to fulfill the following requirements:

· Authorability
Enable the development of computer programs capable of creating, editing, and maintaining VRML 
files, as well as automatic translation programs for converting other commonly used 3D file formats 
into VRML files.

· Composability
Provide the ability to use and combine dynamic 3D objects within a VRML world and thus allow re-
usability. 

· Extensibility
Provide the ability to add new object types not explicitly defined in VRML.

· Implementability
Capable of implementation on a wide range of systems.

· Performance
Emphasize scalable, interactive performance on a wide variety of computing platforms.

· Scalability
Enable arbitrarily large dynamic 3D worlds.

Characteristics of VRML

VRML is capable of representing static and animated dynamic 3D and multimedia objects with 
hyperlinks to other media such as text, sounds, movies, and images. VRML browsers, as well as 
authoring tools for the creation of VRML files, are widely available for many different platforms.

VRML supports an extensibility model that allows new dynamic 3D objects to be defined and a 
registration process that allows application communities to develop interoperable extensions to the base 
standard. There are mappings between VRML objects and commonly used 3D application programmer 
interface (API) features.

Scope

The VRML specification defines a file format that integrates 3D graphics and multimedia. Conceptually, 
each VRML file is a 3D time-based space that contains graphic and aural objects that can be 
dynamically modified through a variety of mechanisms. VRML defines a primary set of objects and 
mechanisms that encourage composition, encapsulation, and extension.

The semantics of VRML describe an abstract functional behaviour of time-based, interactive 3D, 
multimedia worlds. VRML does not define physical devices or any other implementation-dependent 
concepts (e.g., screen resolution and input devices). VRML is intended for a wide variety of devices and 
applications, and provides wide latitude in interpretation and implementation of the functionality. For 
example, VRML does not assume the existence of a mouse or 2D display device.

Each VRML file:



1. implicitly establishes a world coordinate space for all objects defined in the file, as well as all objects 
recursively included by the file;

2. explicitly defines and composes a set of 3D and multimedia objects;

3. can specify hyperlinks to other files and applications;

4. can define object behaviors.

An important characteristic of VRML files is the ability to compose files together through inclusion and to 
relate files together through hyperlinking. For example, consider the file earth.wrl which specifies a world
that contains a sphere representing the earth. This file may also contain references to a variety of other 
VRML files representing cities on the earth (e.g., file paris.wrl). The enclosing file, earth.wrl, defines the 
coordinate system that all the cities reside in. Each city file defines the world coordinate system that the 
city resides in but that becomes a local coordinate system when contained by the earth file.

Hierarchical file inclusion enables the creation of arbitrarily large, dynamic worlds. Therefore, VRML 
ensures that each file is completely described by the objects and files contained within it and that the 
effects of each file are strictly scoped by the file and the spatial limits of the objects defined in the file. 
Otherwise, the accumulation of files into larger worlds would produce unscalable results (as each added 
world produces global effects on all other worlds). For example, light sources have the potential of global
effect since light energy theoretically does not dissipate to zero. And, if the earth file contains 100 city 
files each containing 100 lights each affecting all objects in the world, the lighting calculations would 
quickly become intractable. Therefore, in order to prevent global effects, light source objects are scoped 
by either a maximum radius or by location within the file.

Another essential characteristic of VRML is that it is intended to be used in a distributed environment 
such as the World Wide Web. There are various objects and mechanisms built into the language that 
support multiple distributed files, including:

5. in-lining of other VRML files;

6. hyperlinking to other files;

7. using established Internet standards for other file formats;

8. defining a compact syntax.

See also:
http://www.vrml.org/Specifications/VRML97 



Licensing Details
This licence applies to the registered version of VrmlPad v. 1.0. 

If you are using a trial version of VrmlPad v. 1.0, see the section titled "Evaluation Licence" below.

PARALLELGRAPHICS LIMITED

END-USER LICENCE AGREEMENT

IMPORTANT – READ CAREFULLY: This ParallelGraphics End-User Licence Agreement (the 
“Agreement”) is a legal agreement between you (either an individual or a single entity) and 
ParallelGraphics Limited for the ParallelGraphics software product VrmlPad    v. 1.0 (the “Software”).    
By installing, copying or otherwise using the Software, you agree to be bound by the terms and 
conditions of this Agreement. If you do not agree to the terms and conditions of this Agreement, do not 
install, copy or otherwise use the Software, you may however return the Software to your place of 
purchase for a full refund.

1. Agreement

1.1    ParallelGraphics Limited (“ParallelGraphics”) hereby grants you the following rights for your own 
purposes only, and not those of any third party:

(a) You may install and use one copy of the Software on a single computer (into RAM and/or onto 
computer hard drive);

(b) You may access the Software and query, display and manipulate the data contained therein;

(c) You may make a single copy of the Software for back-up purposes.

1.2    The Software and any associated documentation (the “Documentation”) contain confidential 
information of ParallelGraphics and all copyright, trademarks and all other intellectual property rights in 
and to the Software and Documentation are and shall remain the sole and exclusive property of 
ParallelGraphics. Nothing in this Agreement shall confer any rights in any tradename, business name or 
trademark of ParallelGraphics on you. The provisions of this Clause 1.2 shall continue to operate after 
the termination of this Agreement.

1.3    Save as otherwise expressly set out herein and as otherwise expressly permitted by law, you shall 
not:

(a) Make any temporary or permanent reproduction by any means and in any form, in whole or in part, 
of the Software or the Documentation;

(b) Make any translation, adaptation, arrangement or any other alteration of the Software or the 
Documentation;

(c) Make any form of distribution to the public of the Software or the Documentation, in whole or in part, 
or of copies thereof;

(d) Make any communication, display or performance to the public of the Software or the 
Documentation;

(e) Disseminate, sell, give away, hire, lease, offer or expose for sale or distribute the Software, or 
another product wholly or partially derived from any of the foregoing;

(f) Assign, transfer, sell, lease, rent, charge or otherwise deal in or encumber the Software or the 
Documentation or    use the Software or the Documentation on behalf of any third party, or make 
available the same to any third party without the prior written consent of ParallelGraphics;

(g) Copy, adapt or reverse compile the whole or any part of the Software or the Documentation;

(h) Remove or alter any copyright or other proprietary notice from the Software or the Documentation.

1.4    ParallelGraphics will not be bound by any term, condition or other provision proffered by you which 
is different from or in addition to the provisions of this Agreement unless ParallelGraphics agrees to such
provisions in writing.



1.5    This Agreement supersedes any and all prior agreements, statements and representations 
between ParallelGraphics and you.

1.6    No amendment, modification or waiver of any of the provisions of this Agreement shall be valid 
unless set out in writing and signed by each party.

1.7    If any provision of this Agreement shall be found by any court or administrative body of any 
competent jurisdiction to be invalid or unenforceable, the invalidity or unenforceability of such provision 
shall not affect the other provisions of this Agreement and all provisions not affected by such invalidity or
unenforceability shall remain in full force and effect.

1.8    You shall not be entitled to assign or otherwise transfer this Agreement nor any of its rights or 
obligations hereunder, without the prior written consent of ParallelGraphics.

2. Term and Termination

2.1    ParallelGraphics may terminate this Agreement if you breach any of the terms of this Agreement 
and fail to remedy such a breach within fifteen (15) days of receipt of written notice from 
ParallelGraphics. Upon such termination you shall destroy the Software, and the Documentation and 
any back-up or archival copy of the Software and you shall provide written certification of such 
destruction to ParallelGraphics.

2.2    You may terminate this Agreement at any time by destroying the Software, the Documentation and 
any back-up or archival copy of the Software and notifying ParallelGraphics in writing of such 
destruction.

2.3    All provisions of this Agreement which in order to give effect to their meaning need to survive its 
termination shall remain in full force and effect thereafter.

3. Warranties

3.1    ParallelGraphics warrants that its title to and property in the Software and the Documentation is 
free and unencumbered and that it has the right, power and authority to licence the same upon the terms
and conditions of this Agreement.

4. Consequential Damages

4.1    In no event shall ParallelGraphics be liable for any indirect, incidental, special or consequential 
damages (including without limitation any loss of data or business interruption) arising out of the 
performance or failure of the Software even if such damages were reasonably foreseeable or 
ParallelGraphics had been advised of the possibility of such damages.

5. Liability

5.1    ParallelGraphics does not warrant that the Software and/or the Documentation will meet your 
requirements or that the operation of the Software will be uninterrupted or error free.

5.2    Except as expressly provided herein, all conditions and warranties (express or implied, statutory or 
otherwise) are excluded by ParallelGraphics, including without limitation any warranties implied by the 
Sale of Goods Act 1893 as amended by the Sale of Goods and Supply of Services Act 1980 or by 
Section 39 of the said 1980 Act. 

6. Governing Law

6.1    This Agreement will be governed and construed in accordance with the laws of the Ireland.

*** EVALUATION LICENCE ***

The following licence applies to the trial version of VrmlPad v. 1.0

If you have purchased a licence for the registered version of VrmlPad v. 1.0, see the section "Licence 
Agreement" above.

PARALLELGRAPHICS LIMITED



END-USER EVALUATION LICENCE AGREEMENT

IMPORTANT – READ CAREFULLY: This ParallelGraphics End-User Evaluation Licence Agreement (the 
“Agreement”) is a legal agreement between you (either an individual or a single entity) and 
ParallelGraphics Limited for the ParallelGraphics software product VrmlPad v. 1.0 (the “Software”).    By 
installing, copying or otherwise using the Software, you agree to be bound by the terms and conditions 
of this Agreement. If you do not agree to the terms and conditions of this Agreement, do not install, copy 
or otherwise use the Software. 

1. Agreement 

1.1 ParallelGraphics Limited (“ParallelGraphics”) hereby grants you the following rights for the purposes
of evaluating the Software for your own purposes only, and not those of any third party and only for a 
period of thirty (30) days from the date you first install, copy or use the Software:

(a) You may install and use one copy of the Software on a single computer (into RAM and/or onto 
computer hard drive);

(b) You may access the Software and query, display and manipulate the data contained therein;

(c) You may make a single copy of the Software for back-up purposes.

1.2    The Software and any associated documentation (the “Documentation”) contain confidential 
information of ParallelGraphics and all copyright, trademarks and all other intellectual property rights in 
and to the Software and Documentation are and shall remain the sole and exclusive property of 
ParallelGraphics. Nothing in this Agreement shall confer any rights in any tradename, business name or 
trademark of ParallelGraphics on you. The provisions of this Clause 1.2 shall continue to operate after 
the termination of this Agreement.

1.3    Save as otherwise expressly set out herein and as otherwise expressly permitted by law, you shall 
not:

(a) Make any temporary or permanent reproduction by any means and in any form, in whole or in part, 
of the Software or the Documentation;

(b) Make any translation, adaptation, arrangement or any other alteration of the Software or the 
Documentation;

(c) Make any form of distribution to the public of the Software or the Documentation, in whole or in part, 
or of copies thereof;

(d) Make any communication, display or performance to the public of the Software or the 
Documentation;

(e) Disseminate, sell, give away, hire, lease, offer or expose for sale or distribute the Software, or 
another product wholly or partially derived from any of the foregoing;

(f) Assign, transfer, sell, lease, rent, charge or otherwise deal in or encumber the Software or the 
Documentation or    use the Software or the Documentation on behalf of any third party, or make 
available the same to any third party without the prior written consent of ParallelGraphics; 

(g) Copy, adapt or reverse compile the whole or any part of the Software or the Documentation;

(h) Remove or alter any copyright or other proprietary notice from the Software or the Documentation. 

1.4    ParallelGraphics will not be bound by any term, condition or other provision proffered by you which 
is different from or in addition to the provisions of this Agreement unless ParallelGraphics agrees to such
provisions in writing.

1.5    This Agreement supersedes any and all prior agreements, statements and representations 
between ParallelGraphics and you.

1.6    No amendment, modification or waiver of any of the provisions of this Agreement shall be valid 
unless set out in writing and signed by each party.

1.7    If any provision of this Agreement shall be found by any court or administrative body of any 



competent jurisdiction to be invalid or unenforceable, the invalidity or unenforceability of such provision 
shall not affect the other provisions of this Agreement and all provisions not affected by such invalidity or
unenforceability shall remain in full force and effect.

1.8    You shall not be entitled to assign or otherwise transfer this Agreement nor any of its rights or 
obligations hereunder, without the prior written consent of ParallelGraphics.

2. Term and Termination

2.1    ParallelGraphics may terminate this Agreement if you breach any of the terms of this Agreement 
and fail to remedy such a breach within fifteen (15) days of receipt of written notice from 
ParallelGraphics. Upon such termination you shall destroy the Software, and the Documentation and 
any back-up or archival copy of the Software and you shall provide written certification of such 
destruction to ParallelGraphics.

2.2    You may terminate this Agreement at any time by destroying the Software, the Documentation and 
any back-up or archival copy of the Software and notifying ParallelGraphics in writing of such 
destruction.

2.3    All provisions of this Agreement which in order to give effect to their meaning need to survive its 
termination shall remain in full force and effect thereafter.

3. Warranties

3.1    ParallelGraphics warrants that its title to and property in the Software and the Documentation is 
free and unencumbered and that it has the right, power and authority to licence the same upon the terms
and conditions of this Agreement.

4. Consequential Damages

4.1    In no event shall ParallelGraphics be liable for any indirect, incidental, special or consequential 
damages (including without limitation any loss of data or business interruption) arising out of the 
performance or failure of the Software even if such damages were reasonably foreseeable or 
ParallelGraphics had been advised of the possibility of such damages.

5. Liability

5.1    ParallelGraphics does not warrant that the Software and/or the Documentation will meet your 
requirements or that the operation of the Software will be uninterrupted or error free.

5.2    Except as expressly provided herein, all conditions and warranties (express or implied, statutory or 
otherwise) are excluded by ParallelGraphics, including without limitation any warranties implied by the 
Sale of Goods Act 1893 as amended by the Sale of Goods and Supply of Services Act 1980 or by 
Section 39 of the said 1980 Act.

6. Governing Law

6.1    This Agreement will be governed and construed in accordance with the laws of the Ireland.

E-mail: support@parallelgraphics.com

WWW: http://vrmlpad.parallelgraphics.com



Ordering Information
Trial version of VrmlPad has the following limitations:

· You cannot save the files over 64K.

· You cannot copy or cut selections over 32K to the clipboard.

You are free to evaluate VrmlPad for a period of 30 days before you are required to register the program.
Once you register VrmlPad you will receive a serial number that you can use to expand your copy of 
VrmlPad to the full version. Other benefits of registering VrmlPad include notification of all VrmlPad 
releases and updates, top priority for all your comments and suggestions, and the opportunity to beta 
test future VrmlPad releases.

The cost of VrmlPad is only 29.95 USD, and there are two ways of ordering:

You can purchase VrmlPad by visiting the on-line software shops http://www.buyonet.com or 
https://www.regnow.com/softsell/nph-softsell.cgi?item=3114-1.

You also can order VrmlPad by mail. Please print out the Registration form and send a cheque to:

PARALLELGRAPHICS LIMITED
36 Fitzwilliam St, Dublin 2,
Ireland.

Upon receiving your registration, we will provide you with your serial number (by e-mail). In addition, 
your address will be added to an electronic mailing list to receive notification when new versions of 
VrmlPad become available.

More information concerning VrmlPad ordering you can find at the ParallelGraphics Web site:

http://vrmlpad.parallelgraphics.com/register.html
If you have any further questions, please, contact us at sales@parallelgraphics.com



VrmlPad Registration Form
Send this form along with 29.95 USD to:

PARALLELGRAPHICS LIMITED
36 Fitzwilliam St, Dublin 2,
Ireland.

Name (required):_______________________________________

Address: _____________________________________________

City: _________________________ State: _____ ZIP: ________

Email (required): ______________________________________

Where did you find VrmlPad: ____________________________

We will send you a confirmation email with your serial number when we receive your registration.

Thanks again.

The ParallelGraphics Sales Team



Contacting the Author
The easiest way to contact me is to send email to:

ild@paragraph.ru
or

ild_@hotmail.com
Please include “VrmlPad” and the version number as the subject. I will respond to your email as soon as
I can. I welcome any questions, comments and/or suggestions.

Also, you can get the latest VrmlPad information at the following URL:

http://vrmlpad.parallelgraphics.com/
Thank you for giving VrmlPad a try.

- Ildar Khairoutdinov
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Overview: Text Editor
The VrmlPad environment includes an integrated text editor to manage, edit, and print source files. Most 
of the procedures for using the editor should seem familiar if you have used other Windows-based text 
editors. With the Text editor, you can:

· Set and customize syntax coloring for source VRML files.

· Use AutoComplete for quick entering a VRML keyword, node type, node name, field name, default 
field value or another syntax element.

· Perform advanced find and replace operations in a file, including using regular expressions.

· Use virtual spaces for advanced cursor positioning.

· Navigate through sections of code using the Go To dialog box.

· Use Bookmarks to mark frequently accessed lines in your source file.

· Customize the Text editor with save preferences, tabs, and indents.

· Modify the font style, size, and color.

· Select lines or multiple lines, copy and cut selection into clipboard.

· Split the Text editor window into two or four panes.

· Use drag-and-drop editing within editor window, and between the Text editor and other applications.

Tip    While using the Text editor, in many instances you can click the right mouse button to display a 
shortcut menu of frequently used commands. The commands available depend on what the mouse 
pointer is pointing to.

What do you want to know more about?
Syntax Coloring 

AutoComplete 

Error Processing 

Finding Text 

File Navigation 

Using Drag-and-Drop Editing 

Editor Commands and Keystrokes 



Syntax Coloring
Syntax coloring uses different colors for various code elements, such as keywords, comments, strings, 
URLs, nodes, fields and field values. This coloring gives you visual cues about the structure and state of 
your code.

 To change colors used for syntax coloring
1. From the View menu, choose Options.

2. Select the Format tab.

3. In the Font box, select the font you want.

4. The Font box displays the different fixed-pitch fonts installed on your system. The text sample in the 
Sample box changes to the font you select.

5. In the Size box, select the size to be used with the font you selected.

The Size box displays the sizes available for the selected font. The text sample in the Sample box 
changes to the size you select.

6. In the Colors box, select the type of text you want to color.

7. In the Background box, select a background color.

8. In the Foreground box, select a foreground color.

The Background and Foreground boxes display the standard colors, the Custom setting and the 
Automatic setting. The text sample displayed in the Sample box changes to the color you select.
The behavior of the Automatic setting depends on the element selected. For colors that map to 
standard system elements (such as Text or Selected Text), the Automatic setting sets the element 
to the appropriate system color. For syntax coloring elements and other non-system defined colors, 
the Automatic setting indicates that the foreground color or background color from the parent 
category is to be used.

9. Click OK.
 To disable syntax coloring

1. From the View menu, choose Options.

2. Select the Editor tab.

3. In the Options box, unselect Highlight language syntax checkmark.

4. Click OK.



AutoComplete
The Complete command (Ctrl+Space) opens a dropdown list box in the Text editor that contains the 
VRML identifiers (keywords, PROTO, node and field names, fields types) appropriate to the grammatical
context at the current caret position. To have the list box automatically open as you type your code, 
select Auto list identifiers on the Editor tab in the Options dialog box.

You can find the identifier you want in the list box by:

· Typing the name.

As you type, the identifier that matches the characters you type is selected and moves to the top of 
the list.

· Using the up and down arrow keys to move up and down in the list.

· Scrolling through the list and selecting the identifier you want.

You can insert the identifier into your code by:

· Clicking the identifier.

· Selecting the identifier and pressing SPACE or ENTER to insert the selection.

You can also type Ctrl+Space after a node or PROTO identifier. The command adds braces after 
identifier, inserts empty line and sets there the caret.

After a field declaration or definition the command inserts default field value.



Error Processing
As you type, VrmlPad can automatically check your document and underline syntax and semantic errors 
or possible warnings. There are three types of errors indicated on the status bar at the bottom of the 
VrmlPad window:

· Syntax errors.

Wrong construction underlines by red wavy line and indicates on the status bar by a red pane 
labeled SYN.

· Semantic errors and warnings. Missing, duplicated or type-mismatched identifiers.

Identifier underlines by red dash line and indicates on the status bar by a blue pane labeled SEM.

· Nonmatching braces, square brackets and double quotes.

Status bar indicates this error by a green pane labeled NBR.

 To get explanation for an error:
· Rest the mouse pointer over the wrong construction for a moment and read a ScreenTip for the 

error.

· Double-click the highlighted pane on the status bar. The caret will move to the first error of that type.

To quickly move to the next error, choose Next Error from the View menu, or type F4 (to go to the 
previous error, type Shift+F4).



Finding Text
With the advanced find and replace capabilities of the Text editor, you can search for literal text strings or
use regular expressions to find words or characters. A regular expression is a search string that uses 
special characters to match a text pattern in a file. You can use regular expressions, including tagged 
regular expressions, with both the Find and Replace commands.

With the Find and Replace commands, you can:

· Find text in a document.

· Replace text in a whole document.

· Replace text in a part of a document.

· Use regular expressions.
 To find a text string

1. Move the insertion point to where you want to begin your search.

The editor uses the location of the insertion point to select a default search string.

2. From the Edit menu, choose Find or type Ctrl+F.

3. In the Find what box, type the search text or a regular expression.

Tip    Select the menu button to the right of the box to display a list of regular search expressions. 
When you select an expression from this list, the expression is substituted as the search text in the 
Find what box. If you do use regular expressions, be sure the Regular expression check box is 
selected. You can also use the drop-down list to select from a list of up to 16 previous search 
strings.

4. Select any of the Find options.

5. Start the search by clicking the Find Next or Mark All buttons.
 To start a find without using the Find dialog box
· Type Ctrl+F3 to search a word under the caret position.

· To continue your search, type the Find Next (F3) or Find Previous (Shift+F3) buttons.
 To replace text

1. Move the insertion point to where you want to begin your search.

2. The editor uses the location of the insertion point to select a default search string.

3. From the Edit menu, choose Replace.

4. In the Find what text box, type the search text or a regular expression.

Tip    Click the button to the right of the box to display a list of regular search expressions. When you
select an expression from this list, the expression is substituted as the search text in the Find what 
text box. If you do use regular expressions, be sure the Regular expression check box is selected. 
You can also use the drop-down list to select from up to 16 previous search strings.

5. In the Replace with text box, type the replacement text. 

Tip    Click the button to the right of the box to display a list of tagged expressions you can use as 
replacement text.

6. Select any of the remaining Find options.

7. Start the search by clicking the Find Next, Replace, or Replace All buttons

What do you want to know more about?
Regular Expressions 





Regular Expressions
Regular Expression Description
.(Period.) Any single character
[ ] Any one of the characters contained in the brackets, or any of an ASCII range 

of characters separated by a hyphen (-). For example, b[aeiou]d matches bad, 
bed, bid, bod, and bud, and r[eo]+d matches red, rod, reed, and rood, but not 
reod or roed. x[0-9] matches x0, x1, x2, and so on. If the first character in the 
brackets is a caret (^), then the regular expression matches any characters 
except those in the brackets.

^ The beginning of a line.
$ The end of a line. 
( ) Indicates a tagged expression to retain for replacement purposes. If the 

expression in the Find what text box is (PROTO )OldName, and the 
expression in the Replace With box is \1NewName, all selected occurrences of 
PROTO OldName are replaced with PROTO NewName. Each occurrence of a 
tagged expression is numbered according to its order in the Find what text 
box, and its replacement expression is \n, where 1 corresponds to the first 
tagged expression, 2 to the second, and so on. You can have up to nine tagged
expressions.

c|c Any one of the characters separated by the alternation symbol (|). For example,
(j|u)+fruit finds jfruit, jjfruit, ufruit, ujfruit, uufruit, and so on.

* None or more of the preceding characters or expressions. For example, ba*c 
matches bc, bac, baac, baaac, and so on.

+ At least one or more of the preceding characters or expressions. For example, 
ba+c matches bac, baac, baaac, but not bc.

? None or one of the preceding characters or expressions. For example, ba?c 
matches bc, and bac.

( ) Any sequence of characters between the escaped braces. For example, (ju)
+fruit finds jufruit, jujufruit, jujujufruit, and so on. Note that it will not find jfruit, 
ufruit, or ujfruit, because the sequence ju is not in any of those strings.

[^] Any character except those following the caret (^) character in the brackets, or 
any of an ASCII range of characters separated by a hyphen (-). For example, 
x[^0-9] matches xa, xb, xc, and so on, but not x0, x1, x2, and so on.

\a Any single alphanumeric character [a – zA – Z0 – 9].
\w+ Any white-space characters. The \w+ finds tabs and spaces.
\c Any single alphabetic character [a – zA – Z].
\d Any decimal digit [0 – 9].
\v Any VRML identifier.
\s Any quoted string ("[^"]*").
\ Removes the pattern match characteristic in the Find what text box from the 

special characters listed above. For example, 100$ matches 100 at the end of 
a line, but 100\$ matches the character string 100$ anywhere on a line.



File Navigation
The Text editor provides a variety of methods to move around in a source file. In addition to the standard
Windows navigation mechanisms, the Text editor includes an assortment of commands that enable you 
to move to almost any location in a file. Further, in addition to comprehensive GoTo and Bookmarks 
commands, the Text editor includes several advanced navigation features, such as virtual space.

About Virtual Space
All editors support moving the cursor by one character position. The most common difference among 
text editors is whether you can move the cursor into a location that does not currently contain text. For 
example, if your cursor is on column 20 and there is no text on the line below the current line, moving 
the cursor down can do one of two things: Either the cursor moves to column 1 — because there is no 
text on the line below — or the cursor moves to column 20 of the next line. This behavior is called virtual 
space.

With the Text editor, you can treat text selection and space insertion in two ways. When you select the 
Virtual Spaces option, spaces are inserted between the end of the line and the insertion point before 
new characters are added to the line. When you clear the Virtual Spaces option, the Text editor 
behaves like Microsoft Word for Windows — the insertion point is set to the end of the line.
 To enable virtual space

1. From the View menu, choose Options.

2. Select the Editor tab.

3. In the Options box, select Enable virtual space checkmark.

4. Click OK.

About Go To
The Go To dialog box allows you to jump quickly to several different items in a file, including:

· Lines (type the line number)

· PROTO, node and field declarations (type or select the name of a PROTO, node, or field to go to 
where it is defined)

· PROTO, node and field references (type or select the name of a PROTO, node, or field to go to 
where it is referenced)

· ROUTEs (type or select the known node and field names to go to where it is routed)
 To use the Go To dialog box

1. From the Edit menu, choose Go To.

2. In the Go To what box, select the type of item you want.

3. Enter any additional information required.

4. Click one of the navigation buttons: Go To, Previous, or Next.
Tip    To quickly jump to definition of an identifier (PROTO, node, or field name) under the caret position, 
type Ctrl+F11. To jump to an identifier reference, type F11.

About Bookmarks
You can set bookmarks to mark frequently accessed lines in your source file. Once a bookmark is set 
(Ctrl+F2), you can use menu or keyboard commands (F2 and Shift+F2) to move to it. You can remove a 
bookmark when you no longer need it (Ctrl+F2 again).



Using Drag-and-Drop Editing
Drag-and-drop editing is the easiest way to move or copy a selection of text within a file, between files, 
or between applications. The text you drop remains selected, which makes it easy to copy a chunk of 
text into several places.
 To move text using drag-and-drop editing

1. Select the text you want to move.

2. Drag the selected text to the new location.

Note    You can also use the right mouse button for drag-and-drop editing. Select the text you want, 
and then use the right mouse button to drag the text to a new location. A shortcut menu appears, 
asking if you want to move or copy the selected text.

Tip    At any time during a drag-and-drop procedure, you can click the other mouse button to cancel 
the operation.

 To copy text using drag-and-drop editing
1. Select the text you want to copy.

2. While holding down the CTRL key, drag the selected text to the new location.



Editor Commands and Keystrokes
You can access Text editor commands in many ways: from the menus, from the toolbar, and from the 
shortcut menu. There are many Text editor commands, but not all of them appear on the menus and 
toolbars. The Selection menu (available from the Edit menu) contains some of the most useful edit 
commands, including Format, Indent, Unindent, Tabify, Untabify, Make Uppercase, Make 
Lowercase, and Comment.
Use these key combinations in the Text editor window:
Press To
F1 Get context-sensitive Help on node type under the caret position.
F2 Moves to the line containing the next bookmark.
Shift+F2 Moves to the line containing the previous bookmark.
Ctrl+F2 Toggles a bookmark for the current line on and off.
F3 Finds the next occurrence of the specified text.
Shift+F3 Finds the previous occurrence of the specified text.
Ctrl+F3 Finds the next occurrence of the selected text.
Ctrl+Shift+F3 Finds the previous occurrence of the selected text.
Alt+F3 Finds the specified text.
F4 Moves to the line containing the next error or warning.
Shift+F4 Moves to the line containing the previous error or warning.
F5 Preview the document, using default Web browser and VRML viewer.
F11 Displays an identifier definition.
Shift+F11 Displays an identifier reference.
Ctrl+A Selects the entire document.
Ctrl+C Copies the selection to the Clipboard.
Ctrl+Shift+C Comment or uncomment the selected lines.
Ctrl+F Activates the Find tool.
Ctrl+Shift+F Formats the selection using the smart indent settings.
Ctrl+G Moves to a specified location.
Ctrl+L Deletes the selected lines and puts them on the Clipboard.
Alt+S Synchronize the caret position with a selection in the Scene Tree.
Ctrl+Shift+T Replaces spaces with tabs in the selection.
Ctrl+Alt+T Shows or hides tab characters.
Ctrl+U Makes the selection all lowercase
Ctrl+Shift+U Makes the selection all uppercase.
Ctrl+V Inserts the Clipboard contents at the insertion point.
Ctrl+X Cuts the selection and moves it to the Clipboard.
Ctrl+Y Redoes the previously undone action.
Ctrl+Z Undoes the last action.
Ctrl+] Finds the matching brace.
Ctrl+Shift+] Extends the selection to the matching brace.
Ctrl+Space Opens a dropdown list box that contains the available identifiers.
Ctrl+Shift+Space Replaces tabs with spaces in the selection.
Tab Indents the selection.
Shift+Tab Unindents the selection.
Backspace Deletes the selection or, if there is no selection, the character to the left of the 



cursor.
Ctrl+Backspace Deletes a word to the left.
Ctrl+Del Deletes a word to the right.
Left Arrow Moves the cursor one character to the left.
Shift+Left Arrow Extends the selection one character to the left.
Ctrl+Left Arrow Moves back one word.
Ctrl+Shift+Left Arrow Extends the selection back one word.
Right Arrow Moves the cursor one character to the right.
Shift+Right Arrow Extends the selection one character to the right.
Ctrl+Right Arrow Moves forward one word.
Ctrl+Shift+Right Arrow Extends the selection forward one word.
Up Arrow Moves the cursor up one line.
Shift+Up Arrow Extends the selection up one line.
Ctrl+Up Arrow Scrolls the file contents down one line.
Down Arrow Moves the cursor down one line.
Shift+Down Arrow Extends the selection down one line.
Ctrl+Down Arrow Scrolls the file contents up one line.
Home Moves to either the start of the current line or the start of the text on that line.
Shift+Home Extends the selection to either the start of the current line or the start of the text

on that line.
Ctrl+Home Moves to the beginning of the file.
Ctrl+Shift+Home Extends the selection to the beginning of the file.
End Moves to the end of the current line.
Shift+End Extends the selection to the end of the current line.
Ctrl+End Moves to the end of the document.
Ctrl+Shift+End Extends the selection to the end of the document.
Page Down Moves the cursor down one page.
Page Up Moves the cursor up one page.
Shift+Page Down Extends the selection down one page.
Shift+Page Up Extends the selection up one page.
Del Deletes the selection.
Ins Toggles between inserting and replacing text.



Overview: Scene Tree
The Scene Tree displays VRML hierarchy of your scene and lets you:

· Browse and edit the VRML hierarchy of your scene.

· Edit node, PROTO, and field names.

· Make precise selections within the Text Editor.

For each node, the Scene Tree displays:

· An icon indicating the node type (for Transform , for Shape 
, and so on).

Each node type has a particular icon that is associated with it. Clones (multiple instances) of an 
node are indicated with the link mark  above the node icon.

· The name of the node type (“Transform” for instance).

· The name (if any) that you’ve given to the node.

For each PROTO interface declaration, the Scene Tree displays:

· An PROTO icon .

· The name of the PROTO.

For each field declaration or definition, the Scene Tree displays:

· An icon indicating the field type and category (for exposedField SFNode , for eventIn SFFloat 
, and so on).

ISed fields are indicated with the link mark  above the field icon.

· The name of the field (“children” for instance).

To show only nodes and PROTOs in the Scene Tree, select Show nodes only on the Tree tab in the 
Options dialog box.

What do you want to know more about?
Scene Tree Navigation 

Moving, Copying, and Cloning Nodes 



Naming Nodes 



Scene Tree Navigation
You can see various levels of the hierarchy contained under nodes and PROTOs by clicking the node 
icon. Opening a node refers to expanding the hierarchy beneath it. Closing a node refers to collapsing 
the hierarchy beneath it. You can also click a MFNode field icon to toggle it open and see its values.
 To open or close a node, PROTO, or field:
· Click the + icon to open the item.

· Click the – icon to close the item.

· Type the * button to open all subitems of the selected item.
 To jump to the definition of the selected item (PROTO-instance, nodes clone, or field):
· Choose Go To Definition from the pull-down menu (right-click the item to see the menu).

· Or press Ctrl+F11.
 To jump to the reference of the selected item (PROTO-declaration, node, or field declaration):
· Choose Go To Reference from the pull-down menu.

· Or press F11.

You can synchronize current selection in the Scene Tree with the caret position in the Text Editor in both 
directions.
 To set the caret position in the Text editor at a node, PROTO or field:
· Double-click the item.

· Or select the item and press ENTER.

· Or choose Go To from the pull-down menu.
 To set the selection in the Scene Tree to the node, PROTO or field near the caret position:

1. Activate Text editor window.

2. Choose Synchronize from the View menu (or type Alt+S).

To have the Scene Tree automatically synchronize selection as you type your code, select Automatic 
synchronize context on the Tree tab in the Options dialog box.



Moving, Copying, and Cloning Nodes within the Scene Tree
The top-level nodes in a VRML file are in no particular order; so you can reorder them to suit your tastes 
without changing what your world looks like. You can also move a node (other than a top-level node) or 
field declaration/definition to reorganize the structure of your world.
 To move a node (field) in the scene hierarchy:

1. Select the node (field) you want to move.

2. Click and drag the node (field) icon. When the pointer is over a place where the item can legally be 
inserted, two red arrows appear; if you release the mouse button at that spot, the node (field) is 
inserted there.

Note    When the pointer is over a closed grouping node or a MFNode field, rest the mouse pointer 
over the item for a second and the item will open.

 To copy a node in the scene hierarchy:
1. Select the node you want to copy.

2. While holding down the CTRL key, drag the selected node to the new location.
 To clone a node in the scene hierarchy:

1. Select the node you want to clone.

2. While holding down the ALT key, drag the selected node to the new location below current selection.

Note    If the dragged node is unnamed, Scene Tree prompts you for the node name.

If you use your right mouse button to drag, a menu appears with the available options.



Naming Nodes in the Scene Tree
Using the Scene Tree, you can rename a node, PROTO declaration or field declaration with appropriate 
renaming of all its instances (clones).
 To edit the node name using the Scene Tree:

1. Select the node you want to rename.

2. Press F2 or right click over the node and choose Rename.

3. Type a name in the text box and press Enter or press Esc if you want to leave the text box 
unchanged.

Note:    VRML node names are not allowed to contain spaces, single or double quotation marks, 
pound signs (#), commas, periods, square brackets, backslashes, or curly braces. Also, they can’t 
begin with a numerical digit or the plus (+) or minus (-) characters.

 To clear the node name:
1. Select the node you want to unname.

2. Press F2 or right click over the node and choose Rename.

3. Clear the text box and press Enter.

Note:    If the node name is in use, the Scene Tree warns you about it.
 To rename a PROTO (with all PROTO-instances of this PROTO):

1. Select the PROTO declaration you want to rename.

2. Press F2 or right click over the PROTO and choose Rename.

3. Type a name in the text box and press Enter or press Esc if you want to leave the text box 
unchanged.

 To rename a field declaration (with all references to this field):
1. Select the field declaration you want to rename.

2. Press F2 or right click over the field and choose Rename.

3. Type a name in the text box and press Enter or press Esc if you want to leave the text box 
unchanged.

Note:    To prevent renaming field references inside the inlined vrml-script body, select Disable 
renaming in a script body check box on the Tree tab in the Options dialog box.



Overview: Resource View
The Resource View displays dependencies (resources) of your scene and lets you browse and edit links
to the resources.

For each resource, the Resource View displays:

· An icon indicating the resource type (for ImageTexture , for AudioClips 
, for custom resources 
, and so on).

To determine type of the resource, the Resource View finds the final declaration (unwinding all IS 
statements) of the field or exposed field of type MFString, containing the URL to the resource as a 
first string. The type of standard node or PROTO, that contain this declaration, becoming a type of 
the resource.

Remote resources (beginning with ‘file:’ protocol or with no explicit protocol) are indicated with the 
link mark  above the resource icon.

Missing local resources are indicated with the cross mark  above the resource icon.

· The URL of the resource.

· The name of the resource type (“ImageTexture” for instance).

· The reference count to the resource (number of links to this resource).

· The size of the local resource.

What do you want to know more about?
Managing Resources 

Using Drag-and-Drop 



Managing Resources
You can easily enumerate all links (URLs) to the resource.
 To set the caret position in the Text editor at a resource URL:
· Double-click the item. To move to the next link, double-click the item again.

· Choose Select from the pull-down menu (right-click the item to see the menu).

The list of items in the Resource View may be sorted by URL, by type, by reference count or by file size.
 To sort list of resources:
· Right click an empty space or the header of the Resource View. The Sort by entries in the pull-down

menu let you specify the sort order.

· Or click on the appropriate portion of the list box header.    For example, click on the word “Size” in 
the header to sort by size.    To reverse the sort order, click it again.

Using the Resource View, you can change all links to some resource to the another resource.
 To redirect links to a resource:

1. Select the resource you want to relink.

2. Press F2 or right click over the resource and choose Rename.

3. Type a name in the text box and press Enter or press Esc if you want to leave the text box 
unchanged.

 To browse for a local resource:
1. Right click over the resource and choose Browse.

2. Select a resource file you want to link to.

3. Check Store absolute path if you want to store absolute URL to the resource. Otherwise, relative 
path to the resource will be inserted, if possible.

4. Click OK.
 To convert absolute path to a local resource to relative and vice versa:

1. Right click over the resource and choose Browse.

2. Check or uncheck Store absolute path.

3. Click OK.

If the resource has a file associations, you can open it for previewing or editing using the Resource View.
 To open a resource using associated application:
· Right click over the resource and choose Open or Edit.



Using Drag-and-Drop in the Resource View
You can easily create a new link to resource, using drag-and-drop in the Resource View. You can also 
move or copy a resource file to an another application (Windows Explorer, for instance).
 To create a new link to a resource:

1. Select the resource you want to link to.

2. Drag the selected resource to the location in the Text editor.

When the pointer is over a place where the resource link can legally be inserted, dimmed caret 
appear; if you release the mouse button at that spot, a new link to the resource is inserted there.

Depending on the place you dropping the resource, only URL string may be inserted, or also a node 
of the resource type with the “url” field defined.

 To copy resource file to an another application:
1. Select the resource you want to copy.

2. Drag the selected resource to the application.

If you use your right mouse button to drag, a menu appears with the available options.
 To open VRML resource in the VrmlPad:

1. Select the VRML resource you want to open.

2. Drag the selected resource to the title bar of the VrmlPad.

If you drop a remote resource, VrmlPad automatically downloads it from the Net.



Overview: File List
The File List displays drives, folders, and files accessible from your PC. The right-click menu contains 
file handling commands and you can open Windows Explorer directly to create folders, run searches, 
etc.

 To open VRML file in the VrmlPad:
1. Navigate to the drive and directory you want to access.

2. Double-click on a folder to display its files.

3. Double-click on a file to open it in the editor.

Tip    To have the File List use single-click to open a file, select Single click to open a file (point to 
select) on the File List tab in the Options dialog box.

Tip    To open a file in a new instance of VrmlPad, hold Shift key while opening the file.

You can set the files list to show specific file types. The filter is a global setting for all directories.
 To filter the file list:

1. Open combo box at the bottom of the File List.

2. Select a file type from the list.

The file list refreshes to apply the filter.

What do you want to know more about?
Using Drag-and-Drop 



Using Drag-and-Drop in the File List
Drag-and-drop in the File List works like in Windows Explorer - you can drag files from and to the File 
List using left and right mouse buttons and CTRL or ALT keyboard modifiers.

In addition, you can insert links to files in the Text editor, using drag-and-drop like in the Resource View.
 To create a link to a file in the Text editor:

1. Select the file you want to link to.

2. Drag the selected file to the location in the Text editor.

When the pointer is over a place where the resource link can legally be inserted, dimmed caret 
appear; if you release the mouse button at that spot, a new link to the resource is inserted there.

Depending on the place you dropping the resource, only URL string may be inserted, or also a node 
of the resource type with the “url” field defined.



The Basics of Publishing
Publishing refers to the process of locating all the files necessary to create a document, scene, or world 
and organizing the files for publication on a server. The Publishing Wizard is also able to put the files on 
your Web server, using Microsoft Web Publishing engine, or send it by e-mail, using MAPI transports.

Publishing is a one-way process. Publishing leaves your original files alone, but as it makes copies of 
those files it changes and optimizes those copies. Any time you want to change your world, reopen the 
original source files for the world, then make changes and republish. Don't modify the published copies 
directly.



Setting Up the Destination
The first step of the publishing process is to choose a destination for your published files.

If you have already published your scene, choose an existing destination directory. Later in the 
publishing process, the Publishing Wizard may remove the contents of the directory before creating the 
new version of the published world.

If you haven't previously published your scene, enter a name for a new destination directory (which the 
Publishing Wizard then creates for you), or click the Browse button and choose a directory from the file 
browser.

If you have selected Pusblish files to the net option for the first time, get ready to download and install 
the latest version of Microsoft Web Publishing Wizard. It automates the process of copying files from a 
temporary destination directory to the Web or FTP server.

Click Next when you're done.

If you change your mind, you can come back to this dialog by clicking a Back button. At any point in the 
publishing process you can click Cancel to stop the process without publishing.

If you already published some scenes, you can click Finish to complete the process now using recently 
used settings for the rest of the dialogs.



Choosing Additional Resource Directories
The next step of the publishing process is to choose the additional resource directories. Some scenes 
may contain invalid links to the resources, that that are possibly kept somewhere. To help the Wizard 
find these resources, you can specify a list of directories. Starting from these directories, the Publishing 
Wizard will search missing resources.
 To add a directory to the list:

1. Click the Add button.

2. Choose a directory from the file browser.

3. Click OK.

Click Next when you're done, or Back to return to the previous Wizard step.



Excluding Files from Publishing
This step lets you list files that you don't want the Publishing Wizard to include. You might want to 
exclude files that have been previously published, files that have been manually checked, files you know
will already be on the Web server, or test files that you don't want to include in the final world.

Exclude filenames from the publish by selecting them in the list, then click Exclude. Revert this 
operation by selecting filenames in the list, then click Include. Excluded filename are marked by a cross 
mark .

URLs in your document which refer to these files are left unchanged in your documents.

Click Next when you're done, or Back to return to the previous Wizard step.



VRML Optimization Options
This step of the publishing process lets you choose options to optimize your world.

· Pack VRML files using maximum compression
Compressed files download faster and use less disk space, so use of this feature is recommended. 
Most browsers automatically decompress files that have been compressed. To disable this feature, 
click the box to remove the check.

· Remove extra formatting from VRML files
Check the box if you want the Publishing Wizard to reformat the VRML files by unindenting lines, 
removing unnecessary whitespaces and empty lines. Reformatted files use less disk space, but 
usually lost in human readability.

· Remove comments
Selecting this option removes all comments from a file during the reformat.

· Remove default field values
Selecting this option removes field values which are explicitly declared with a value identical to the 
default field value.

· Simplify floating point numbers
Check the box if you want the Publishing Wizard when possible to reduce float numbers to integers 
without lost of quality, remove trailing zeros and remove unnecessary zero values to the left of 
decimal point. For example, number 10.0 reduce to 10, 0.10 – to .1 and so on.

· Adjust numeric resolution
This option also removes unnecessary text, but in some cases such removal is lossy, and in other 
cases there may be external code, such as an EAI application, relying on the text. So you should be 
considered carefully before use the option.

This option adjusts numeric resolution of floating point numbers. In many cases, exporters output 
these numbers with a much greater resolution than necessary. The sub-options allow resolution to 
be indicated by type of the number. For example, coordinate resolution relates to all world 
coordinates and sizes: the point field in the Coordinate node, the size field in the Box node and so 
on. Orientation resolution relates to all SFRotation and MFRotation fields and also to the fields that 
defines angles.

Click Next when you're done, or Back to return to the previous Wizard step.



Specifying Directory Organization
In this step, you decide whether you want to use a flat directory structure, or whether you want to use a 
hierarchical structure.

· Put all source files in one directory
This is the best choice if your world uses only a few files.

· Arrange a source files in subfolders, depending of its type
Use the resource type based directory structure. This is the best choice if you have a complex multi-
file world.

· Retain the same directory structure used by the source files
Use the same directory structure that your source files use. This is the best choice if you have a 
complex multi-file world stored in a set of nested directories.

Click Next when you're done, or Back to return to the previous Wizard step.



Reviewing the Directory Structure
In this step, you review the directory structure. This dialog lists every file that will be placed in the 
destination directory. If the files don’t have the names and locations you expect, click Back to go back to
the mappings dialog.

Click Next when you're done, or Back to return to the previous Wizard step. Your files are set up for final
publishing when you click Next, so you can't turn back to previous steps from this point.



Previewing Published Documents
The final step of the Publishing lets you preview the published world immediately. Click Preview to 
preview the world in your default browser. Click Open Folder to open the destination directory with your 
files, using Windows Explorer window.

If you have chosen publishing to the net or through e-mail in the first step, click Next to launch Microsoft 
Web Publishing Wizard or mail sender. Otherwise, click Close to finish publishing.



Resolving Broken Links
You encounter an error during publishing. The Publishing Wizard has found broken links to some 
resources. To continue, you can choose one of the following ways:

· If you know exact location of the missing resources, you can resolve it manually:

1. Select a link in the list below.

2. Click the Resolve button.

3. Choose a resource file from the file browser.

4. Click OK.

5. Repeat from the step 1 until there are no more links in the list.

· If some of the missing resources located in a known directory, return Back to the previous page and 
add this directory to the list of additional resource directories.

· You may skip this page, removing broken links from a source VRML file(s). Select the Yes radio-
button and click the Next.

· Finally, you can Cancel publishing and look into your VRML sources.



Publishing Errors
You encounter an error during publishing. The Publishing Wizard has found some errors or warnings in 
the VRML files to be publishing. The dialog box lets you copy errors to the clipboard so you can paste 
them into a text editor for future reference.

If the listed errors is serious enough, Cancel publishing and fix errors. Otherwise, click Next to continue 
publishing.



Hints and Tips
Basic
How to compress a VRML file 

How to download a VRML file from the Net. 

How to upload a VRML file to a remote server. 

How to quickly find the definition (reference) of an identifier. 

How to insert a pair of node or PROTO braces. 

How to insert default field value. 

How to indent a block of lines. 

How to comment a block of lines or an entire node. 

How to locate a syntax or semantic error. 

Advanced
How to make a VRML file smaller. 

How to expose a field to a PROTO interface. 

How to register a VRML extension. 

How to change a set of the standard nodes. 

How to change a source of the Node Help. 



How to compress a VRML file
Compressed files download faster and use less disk space, so use of this feature is recommended. Most
browsers automatically decompress files that have been compressed.
 To compress an existing VRML file:

1. From the File menu, choose Open.

2. Select your file.

3. Click OK.

4. Change the compression level, if you like, as written below.

5. From the File menu, choose Save As.

6. Select Save compressed checkbox.

7. Enter or select a destination file name.

8. Click OK.
 To change default compression level:

1. From the View menu, choose Options.

2. Select the General tab.

3. Use the Default compression drop-down list to select the compression level:

· Maximum – best compression, but lowest speed of compression;

· Normal – balance between speed and compression quality;

· Fast – fastest speed, but poor compression quality.

4. Click OK.
 To compress a file without using the Save As dialog box:

1. Double-click the pane GZ in the status bar at the bottom of VrmlPad window.

2. From the File menu, choose Save, or type Ctrl+S.



How to download a VRML file from the Net.
 If you are using download dialog for the first time:

1. From the View menu, choose Options.

2. Select the General tab.

3. Enter or browse destination directory in the Location for downloaded files box.

This directory will keep a downloaded files and its resources – images, audio files, scripts, etc.

4. Specify additional download options.

5. Click OK.
 To download a file:

1. From the File menu, choose Download, or double-click the pane WEB in the status bar at the 
bottom of VrmlPad window.

2. Type valid Internet address (URL) of your file to the Open box, or use the drop-down list to select 
previous URLs. When you select an URL in this list, the URL is added in the Open box.

3. Click OK.
 To download a file without using the Download dialog box:
· Drag-and-drop an Internet shortcut from your Web-browser to the caption of VrmlPad.
 To cancel downloading:
· Double-click the animated globe in the status bar at the bottom of VrmlPad window.



How to upload a VRML file to a remote server.
First of all you should download and install the latest version of Microsoft Web Publishing Wizard from 
http://www.microsoft.com/windows/software/webpost/. It automates the process of copying files 
from your PC to the Web or FTP server.
 To upload a VRML file using Microsoft Web Publishing Wizard:

1. Open the file into VrmlPad.

2. From the File menu, choose Publish.

3. Select Pusblish files to the net options in the first page.

4. Proceed through a following pages of the Publishing Wizard.

5. After the last page, follow instructions of the Microsoft Web Publishing Wizard. For the first time, 
specify there path to your FTP server, user name and login.



How to quickly find the definition (reference) of an identifier.
 To jump to the definition of an identifier (PROTO, node, or field name):

1. Position the caret at the identifier in the Text editor, or select an identifier in the Scene Tree.

2. Select Go To Definition from the pull-down menu or type Ctrl+F11.
 To jump to the reference of an identifier (PROTO, node, or field name):

1. Position the caret at the identifier in the Text editor, or select an identifier in the Scene Tree.

2. Select Go To Reference from the pull-down menu or type F11.

3. Select Next Reference from the pull-down menu or type F11 to jump to the next reference of the 
identifier.



How to insert a pair of node or PROTO braces.
 To insert a pair of braces after node or PROTO name:

1. Position the caret to the space after node or PROTO name.

2. Type Ctrl+Space.



How to insert default field value.
 To insert a default value after field declaration or definition:

1. Position the caret to the space after the field declaration or definition or inside multiple field value.

2. Type Ctrl+Space.



How to indent a block of lines.
 To indent a block of lines:
· Select the lines and then press Tab.
 To unindent a block of lines:
· Select the lines and press Shift+Tab.
 To format a block of lines using the smart indent settings:
· Select the lines and press Ctrl+Shift+F.



How to comment a block of lines or an entire node.
 To comment a block of lines:
· Select the lines and press Ctrl+Shift+C.
 To uncomment a block of lines:
· Select the commented lines and press Ctrl+Shift+C.
 To comment a node, PROTO declaration or field:
· Select the identifier of a node, PROTO declaration or field in the Scene Tree and choose the 

Comment from the pull-down menu or press Ctrl+Shift+C.



How to locate a syntax or semantic error.
 To jump to the the first error:
· Double-click on the highlighted error indicator in the status bar at the bottom of the VrmlPad window.
 To jump to the the next error:
· From the View menu, choose Next Error or type F4.



How to make a VRML file smaller.
Reducing file size and improving reliability and performance go hand in hand. VrmlPad can automatically
remove code that is unnecessary, redundant or unusable. The size reduction is often dramatic, and the 
resulting file is more likely to run consistently across browsers.
 To reduce file size using the Unused Identifiers dialog box:

1. From the View menu, choose Unused Identifiers.

2. In the list below, select identifiers you want to remove.

3. Click Delete or type Del.

Note    You can savely remove default field values. Remove an identifiers of the other types with 
caution – some node names or field declarations may be used by outer scripts, EAI or ActiveX 
components. Also, some VRML authoring tools may use unnecessary for rendering node names and
field declarations for holding additional user interface information, such as object names and 
properties.

 To reduce file size using the Publishing Wizard:
1. From the File menu, choose Publish.

2. In the first page, choose copying document to a folder.

3. Proceed through the following pages up to the Specify VRML preferences page.

4. Select the options you want to.

5. Proceed through the rest of the Wizard.



How to expose a field to a PROTO interface.
 To automatically expose a field:

1. Position the caret to the space after the field definition or Script node’s field declaration (without a 
field value).

2. Type the IS keyword into your code and press SPACE.

3. Type Ctrl+Space and select one of the choices.

There are four possible choices in the case of the exposedField:

· Expose the field as a exposeField declaration.

· Expose the field as a field declaration.

· Expose the field as a eventIn declaration.

· Expose the field as a eventOut declaration.

4. Press SPACE or ENTER.



How to register a VRML extension.
VRML extension is a custom node types in addition to a set of the standard VRML97 nodes.
 To register a VRML extension:

1. Create a VRML file (in VrmlPad, for instance), containing PROTO declarations with an empty 
bodies. This PROTOs should describe your VRML extension – names of the additional node types, 
field names, categories and types.

Note    Actually, a set of the standard VRML97 nodes implemented internally in VrmlPad as a hidden
VRML file. To open it in the editor, type Ctrl+Shift+N.

2. Save the file somewhere.

3. From the View menu, choose Options.

4. Select the General tab.

5. Select Enable VRML extensions checkbox.

6. Type in the Source field path to the saved file or browse it using a button at the right of the field.

7. Click OK.

8. Restart VrmlPad.



How to change a set of the standard nodes.
 To change a standard set of node types, using VrmlPad:

1. Type Ctrl+Shift+N to load the standard nodes as a PROTO declarations.

2. Make all changes you want to.

3. Save the file somewhere.

4. From the View menu, choose Options.

5. Select the General tab.

6. Select Enable VRML extensions checkbox.

7. Type in the Source field path to the saved file or browse it using a button at the right of the field.

8. Select Ignore all standard node types checkbox.

9. Click OK.

10. Restart VrmlPad.



How to change a source of the Node Help.
Help for the standard VRML97 nodes is available through the Help for Current Node from the Help 
menu. By default, VrmlPad uses remote HTML manual 
http://www.vrml.org/technicalinfo/specifications/vrml97/part1/nodesRef.html, but you can 
download the manual into your PC and redirect VrmlPad on it.
 To change a Node Help source:

1. From the Windows Start menu, choose Run.

2. In the Open box, type ‘regedit’, and click OK.

3. Open registry key HKEY_CURRENT_USER/Software/ParallelGraphics/VrmlPad/Settings.

4. Create a new string value, named ‘NodesRef’.

5. Specify in this value full path to your downloaded manual, for example – ‘C:\VRML Spec\part1\
nodesRef.html’.



Processes your input and carries out any default action, such as closing the dialog box.



Cancels your input and carries out the default action, such as closing the dialog box.



Provides a space for you to specify the search text or the regular expression to match. Type the text or expression in the Find 
what box. Use the drop-down list to select previous search strings. Use the right-arrow button to the right of the drop-down list to 
display a list of regular search expressions. When you select an expression in this list, the expression is added as search text in 
the Find what box. If you use regular expressions, be sure the Regular Expression check box is selected. You can also use the 
drop-down list to select from a list of up to 16 previous search strings.
See also: Finding Text 



When selected, finds text strings that match the Find what string and are preceded and followed by a space, tab, or punctuation 
character, or are at the start or end of a line. Otherwise, the search finds any matching string, whether it is a fragment of a larger 
string or not.



When selected, searches for text strings that match the case of the characters in the Find what string exactly. Otherwise, the 
search finds strings with either uppercase or lowercase characters that match the characters in the Find what string.



When selected, finds regular expressions for the search specified in the Find what box.



When selected, indicates that the direction of the search will be from the current cursor position to the beginning of the file, and 
then back to the current cursor position.



When selected, indicates that the direction of the search will be from the current cursor position to the end of the file, and then 
back to the current cursor position.



Displays a list of regular search expressions. When you select an expression in this list, it is added as search text in the Find what
box.



Begins the find operation specified by the values displayed in this dialog box.



Click to place a bookmark on all instances of the word or expression in the Find what box.



Provides a space for you to specify the string of characters to replace the characters found. You cannot use regular expressions in 
the string, but you can use tagged expressions.



Click to display a list of up to nine tagged expressions that you can use as replacement text in the Replace with text box.



Replaces strings in the current selection only. This option is disabled when no text is selected.



Replaces strings in the entire file.



Click to replace the currently selected string with the string specified in the Replace with text box.



Click to replace all strings that match the Find what string automatically, without requiring confirmation for each replacement.



Displays a list of Go To items such as Lines, PROTO, Node and field names, PROTOs.
See also: File Navigation 



Provides space for you to type text for additional selection criteria or select an item from a list. The additional selection criteria you 
enter depend on the Go to what selection. For example, if you select Node definition in the Go to what box, you enter a node 
name.



Click Go To to jump directly to the item displayed in the Go to what list and the Go to what edit box. For example, if you select 
Line in the Go to what list and enter 240 in the Go to what edit box, you will jump in the current document to line 240.



Click Next to jump directly to the next item of the type selected in the Go to what list. For example, if PROTO instance is selected
in the list box, select one from the Enter PROTO name list box and click Next to jump to the next PROTO instance in the current 
document.



Jumps directly to the previous item of the type selected in the Go to what list. For example, if PROTO instance is selected in the 
list box, select one from the Enter PROTO name list box and click Previous to jump to the previous PROTO instance in the 
current document.



The checkbox determines whether you will be able to open VRML files using VrmlPad from the Windows Explorer’s pull-down 
menu. If this option is checked, the following extensions will be associated with VrmlPad: WRL, WRL.GZ, WRZ, and VRML. If this 
option is not checked, VrmlPad will ensure it is not associated with these extensions.



Open VRML files using VrmlPad choosing Open from the Windows Explorer’s pull-down menu or double-clicking on VRML files.



Open VRML files using VrmlPad choosing Edit from the Windows Explorer’s pull-down menu.



Open VRML files using VrmlPad choosing Sent To from the Windows Explorer’s pull-down menu.



If this checkbox is selected, VrmlPad is automatically added to the Taskbar Start menu. Uncheck this option to remove VrmlPad 
from the Start menu.



If this checkbox is selected, a shortcut to VrmlPad is added to the desktop. Uncheck this option to remove the VrmlPad shortcut 
from the desktop.



Select this checkbox to specify that VrmlPad automatically reload externally modified file that has been loaded (but not yet 
changed) by the editor.



If this checkbox is selected, VrmlPad will save uncompressed files with CR/LF end of line indicator. If not, VrmlPad will terminate 
lines only by LF character.
CR/LF is short for Carriage Return/Line Feed, the standard end of line indicator. Unix text files usually contain lines ending in Line 
Feed characters only, and Macintosh text files usually contain lines ending in a Carriage Return character.    The standard 
Windows Notepad program and many other Windows programs require a Carriage Return and Line Feed at the end of each line.



Choose the default compression level at which the VRML file is compressed.



Provides a space for you to specify the root folder for downloaded files. You can download a remote VRML file to this folder by 
choosing Download from the File menu. Also for the file resources a subfolder will be created in the same folder.



Choose a root folder for downloaded files from the file browser.



If this checkbox is selected, VrmlPad will download in addition to remote VRML file also its resources (dependencies).



If this checkbox is selected, VrmlPad will recursively download all subdependencies of VRML resources. Otherwise, only 
immediate dependencies of specified remote file will be downloaded.



If this checkbox is selected, VrmlPad will download only resources with specified relative URLs. For example, a resource linked in 
a VRML file as “img/pic1.gif” will be downloaded, as “http://www.microsoft.com/index.htm” – will not.



If this checkbox is selected, VrmlPad will try to retain the same directory structure used by the remote source files.



Select this checkbox to extend or change the set of standard VRML97 nodes. For example, if you want to learn VrmlPad to work 
with custom node types, create a VRML file, containing PROTO interfaces with empty PROTO definitions, select this checkbox 
and specify in the Source editbox path to your file.
You should restart VrmlPad after this operation to changes take effect.



Provides a space for you to specify the full path name of VRML extensions source file. This file must be a valid VRML file and 
should contain PROTO interfaces of a custom node types. Corresponding PROTO definitions (bodies) are ingored by VrmlPad, so 
it can be empty.
You should restart VrmlPad after this operation to changes take effect.



Choose a full path name of VRML extensions source file from the file browser.



Select this checkbox to disable the standard VRML97 node types. In the Source textbox you can specify a source file for you own 
declaration of VRML node types including standard nodes and VRML extensions.



You can modify the Text editors's behavior by selecting the following options:
Horizontal scroll bar
Select this checkbox to include horizontal scroll bar in editor window.
Vertical scroll bar
Select this checkbox to include vertical scroll bar in editor window.
Dispay whitespace characters
Select this checkbox to show tab characters and spaces.
Enable virtual space
Allows the cursor into locations that do not currently contain text.
Highlight language syntax
Enables syntax coloring.
Drag-and-drop text editing
Select this checkbox to enable drag-and-drop text editing so you can move or copy selected text with the mouse.
Enable copy without selection
Enables the copy command to copy the entire line in which the cursor is placed.
Enable syntax tips
When selected, displays on-screen descriptions of VRML identifiers, braces and field values when you float your cursor over the 
text.
Auto list identifiers
Select this checkbox to enable AutoComplete list box automatically open as you type your code.
Protect read-only files from editing
Prevents you from using the Text editor to modify read-only files.



Provides a space for you to specify the number of space characters that equal one tab character. The default is four space 
characters.



Provides a space for you to specify the column width in spaces between indent locations. The default is four spaces. Pressing the 
TAB key once moves the cursor to the next indent location.

Tab size and Indent size work together in this way: If you have an Indent size of seven characters, a Tab size of three 
characters, and the insertion point in a text file is at indent location, pressing the TAB key once inserts two tab characters (each 
three spaces wide) plus one space character (one space wide) to move the seven character positions to the next indent location.



Convert tabs to the number of spaces specified int the Tab size box when you editing or save a file.



Saves tabs as tab characters when you save a file.



None
Does not indent source code automatically.
Default
Indents source code using the tab and indent sizes.
Smart
Indents open and closing braces to have VRML code best look.



Lists the available fixed-pitch fonts. Select the font name from the drop-down list.



Lists the available font sizes. Select the font size from the drop-down list.



Lists the window elements for which you can specify a foreground or background colors. The Background and Foreground 
boxes display the standard colors, the Custom setting and the Automatic setting. The text sample displayed in the Sample box 
changes to the color you select.
The behavior of the Automatic setting depends on the element selected. For colors that map to standard system elements (such 
as Text or Selected Text), the Automatic setting sets the element to the appropriate system color. For syntax coloring elements 
and other non-system defined colors, the Automatic setting indicates that the foreground color or background color from the 
parent category is to be used.



Lists the foregroung color for the selected element in the Colors list. Click the arrow to display the standard colors, Custom colors
or Automatic. For syntax coloring elements and other non-system defined colors, the Automatic setting indicates that the 
foreground color from the parent category is to be used.



Lists the backgroung color for the selected element in the Colors list. Click the arrow to display the standard colors, Custom 
colors or Automatic. For syntax coloring elements and other non-system defined colors, the Automatic setting indicates that the 
background color from the parent category is to be used.



Select this checkbox to have the Scene Tree automatically synchronize selection to the node, PROTO or field near the caret 
position in the Text editor.



Select this checkbox to show only nodes and PROTOs in the Scene Tree.



Select this checkbox to specify that Scene Tree show named nodes using bold font style.



Select this checkbox to specify that Scene Tree show missing or illegel identifiers using gray font color.



Select this checkbox to prevent renaming field references inside the inlined vrml-script body during renaming a field declaration.



Select this checkbox to specify that the Resource View automatically resize columns to fit all list items.



Resource View's default action is to use the Windows Explorer style of file selection, requiring that the resource name itself be 
clicked. This option allows you to click anywhere on the resource's row of information in order to select it.



Choose the default action that the Resource View performs on double-click or pressing ENTER on a resource item.



Select this checkbox to specify that File List should synchronize the current system directory to the current displayed directory.



Select this checkbox to specify that File List automatically set the current displayed directory to the self directory of a recent loaded
file.



File List's default action is to use the Windows Explorer style of file selection in details view, requiring that the file name itself be 
clicked. This option allows you to click anywhere on the file's row of information in order to select it.



Select this checkbox to display grid lines in details view to separate rows and columns in the File List.



Select this checkbox to specify that File List show icons as they would appear in Windows Explorer. Otherwise a set of generic 
items are used.



Specifies that you want to open items in File List by single-clicking them, just like you would click a link on a Web page. To select 
an item without opening it, you would rest your mouse pointer on it.



Specifies that you want icon titles in File List to appear no underlined.



Specifies that you want icon titles in File List to appear underlined only when you rest your mouse pointer on the title.



Specifies that you want icon titles in File List to appear underlined, just like links on a Web page. For this to apply, you must be 
sure that the Underline links setting in the browser is not set to Never.



Specifies that you want to single-click an item to select it, and double-click an item to open it. This is traditional Microsoft Windows 
model.



Specifies that you want to open VRML files in new VrmlPad window or not.



Select this checkbox to specify that File List on start-up set the current displayed directory to system default folder.



Select this checkbox to specify that File List on start-up set the current displayed directory to last opened file during your last 
VrmlPad session.



Select this checkbox to specify that File List on start-up set the current displayed directory to the specified folder.



Provides a space for you to specify the start-up folder.



Choose a start-up folder from the file browser.



Select this checkbox to specify that Resource View insert reference to the selected file as a full URL. Otherwise, relative URL will 
be inserted, if possible.



Provides a space for you to specify the full Internet address (URL) of a VRML file to download. Type the URL in the Open box. Use
the drop-down list to select previous URLs. When you select an URL in this list, the URL is added in the Open box.



Lists all local dependencies of the document, recursively including a subdependencies of Inlines and EXTERNPROTOs (but not 
Anchors). For each dependency, the Document Weight displays:
· An icon indicating the resource type.
· The full file path to the resource.
· The file size of the resource (for the VRML resources – uncompressed size).
· The size of the VRML resource, being compressed with maximum compression level.
You can sort the list by clicking on the appropriate portion of the list box header. To reverse the sort order, click it again.



The size of the document, being saved with maximum compression level.



The total size of all local dependencies of the document, listed above. For the VRML dependencies, accounts the compressed 
size.



The total size of all local dependencies of the document plus the size of the document itself.



Estimated download time for the document and the listed dependencies using modem on 14.4 kbps.



Estimated download time for the document and the listed dependencies using modem on 28.8 kbps.



Estimated download time for the document and the listed dependencies using modem on 56.6 kbps.



Prints a VRML keywords using bold font style.



Prints a comments, using italic font style.



Prints the document, except numbers inside MFInt32, MFFloat, MFVec2f, MFVec3f, and MFRotation field values.



Prints an erroneous text, using strikeout font style.



Select this checkbox to compress the document before saving. Otherwise, the file will be saved as is, i.e. uncompressed. You can 
specify the compression level in the Default compression box on the General tab in the Options dialog box.



Lists unused node names, field and PROTO declarations, default field values. For each identifier, the Unused Identifiers displays:
· An icon indicating the node type or field type and category.
· The name of the identifier.
· The name of the identifiers type.
· The line number.
You can sort the list by clicking on the appropriate portion of the list box header. To reverse the sort order, click it again.



Choose a category of listed unused identifiers.



Jumps directly to the selected identifier. You can also double-click an identifier to see it in the Text editor, or select it and press 
ENTER.



Deletes all selected identifiers. This operation can be undone, but perform it with caution.




